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1 Einleitung

Der Ozon-Tester Aeroqual ist ein hochgenaues Messgerat zur Messung der Ozonkonzentrationen in
unserer Umluft. Der Ozon-Tester Aeroqual kann mit einem von vier, sich in dem Messbereich
unterscheidenden, Sensorképfen bestlickt werden. Die Einsatzmdglichkeiten des Ozonmesser Aeroqual
erstrecken sich innerhalb der Industrie auf Betriebe der Papier-, Textil-, oder Schmierstoffherstellung die
in ihren Prozessen zum Bleichen von Olen, Fetten, Wachs, Papier, synthetischen Fasern, Zellstoff oder
Textilien Ozon verwenden. Einen weiteren Einsatzbereich findet der Ozontester Aeroqual nach und
wahrend Reinigungsarbeiten, Desinfektionsarbeiten und Entkeimungsarbeiten die z.B. in
Schwimmbadern Wasseraufbereitungsanlagen oder nach Brandschaden und Wasserschaden mit Ozon
durchgefiihrt werden. Mit dem Sensorkopf fiir den unteren Messbereich bis 0,150 ppm kénnen Ozon
Konzentrationen gemessen werden die auf die Befindlichkeit des Menschen negativ wirken. Durch die
Verwendung fihrender GSS Technology Sensoren hat der Ozonmesser Aeroqual eine hohe
Messgenauigkeit sowie eine sehr lange Lebensdauer der Sensorkdpfe. Die einzigartige Méglichkeit die
Sensoren zu refreshen, bietet gegenlber anderen Sensor-Technologien, eine kostengiinstige
Unterhaltung der Geréte. Je nach Model kdnnen die gemessenen Konzentrationen tber eine analoge
Schnittstelle mit einem 0...5 V Ausgangsignal ausgegeben, in dem internen Speicher geschrieben oder
Uber eine RS232 Schnittstelle zu einem PC Ubertragen werden. Durch die Einfachheit der Bedienung
kénnen in kurzester Zeit die Alarmschwellen fiir die optische oder akustische Signalisierung verandert
werden. Auf dem LCD Display werden neben den gemessenen Konzentrationen, die in ppm oder mg/I
angezeigt werden, auch die hoch und tief Alarme dargestellt.

1.1 Lieferumfang

1 x Basisgerat Serie 300/500

1 x Sensorkopf

1x 12V DC 800 mA AC/DC Steckernetzgerat

1 x Bedienungsanleitung

1 x Akkupack 9,6 V Serie 300/500

1 x Software und Datenkabel (USB) (nur bei Serie 500)

2 Sicherheit

Bitte lesen Sie vor Inbetriebnahme des Gerates die Bedienungsanleitung sorgsam durch. Schaden, die
durch Nichtbeachtung der Hinweise in der Bedienungsanleitung entstehen, entbehren jeder Haftung.

2.1 Warnsymbole

Betriebsspannung unter Sollwert.
Batterien auswechseln, sonst Fehimessungen mdglich

Allgemeine Warnung.
Ziehen Sie unbedingt die Dokumentation zu Rate.

2.2 Warnhinweise

e Dieses Messgerat darf nur in der in dieser Bedienungsanleitung beschriebenen Art und Weise
verwendet werden. Wird das Messgerat anderweitig eingesetzt, kann es zu einer Gefahr fir den
Bediener sowie zu einer Zerstérung des Messgerates kommen.

e Gerat keinen extremen Temperaturen, direkter Sonneneinstrahlung, extremer Luftfeuchtigkeit
oder Nasse aussetzen.

e Das Offnen des Gerategehauses darf nur von Fachpersonal der PCE Deutschland GmbH
vorgenommen werden.

e Das Messgerat darf nie mit der Bedienoberflache aufgelegt werden (z.B. tastaturseitig auf einen
Tisch).

e Benutzen Sie das Messgerat nie mit nassen Handen.

e Es durfen keine technischen Verdnderungen am Geréat vorgenommen werden.

e Das Geréat sollte nur mit einem feuchten Tuch gereinigt werden. Keine Scheuermittel oder
I6semittelhaltige Reinigungsmittel verwenden.
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e Das Gerat darf nur mit dem von PCE Deutschland angebotenen Zubehor oder gleichwertigem

Ersatz verwendet werden.

o Vor jedem Einsatz dieses Messgerates, bitte das Gehause auf sichtbare Beschadigungen
Uberprifen. Sollte eine sichtbare Beschadigung auftreten, darf das Geréat nicht eingesetzt

werden.

e Weiterhin darf dieses Messgerat nicht eingesetzt werden wenn die Umgebungsbedingungen
(Temperatur, Luftfeuchte ...) nicht innerhalb der in der Spezifikation angegebenen Grenzwerten

liegen.

e Setzen Sie den Sensorkopf (nur Ozon) keiner tibermafRig hohen Ozonkonzentration aus. Das
Gerét ist fur ubliches Umgebungsklima, nicht fur direkte Ozonstromungen ausgelegt.

o Das Messgerat darf nicht in einer explosionsféhigen Atmosphére eingesetzt werden.

e Wenn die Batterie leer ist, (wird z. B. durch den Batterieindikator angezeigt) darf das Messgerat
nicht mehr verwendet werden, da durch falsche Messwerte Lebensgefahrliche Situationen
entstehen kénnen. Nachdem wieder volle Batterien eingesetzt wurden, darf der Messbetrieb

fortgesetzt werden.

e Vor jedem Einsatz bitte das Messgerat durch das Messen einer bekannten Grol3e tGberprifen.
o Die in der Spezifikation angegebenen Grenzwerte fir die MessgréRen dirfen unter keinen

Umstanden Uberschritten werden.

e Wenn das Messgeréat Uber eine langere Zeit nicht eingesetzt werden soll, entfernen Sie bitte die
Batterien, um eine Beschadigung durch ein Auslaufen der Batterie zu vermeiden.
e Bei Nichtbeachtung der Sicherheitshinweise, kann es zur Beschadigung des Gerates und zu

Verletzungen des Bedieners kommen

Fragen kontaktieren Sie bitte die PCE Deutschland GmbH.

Spezifikationen

Messeinheiten

Spannungsversorgung

Schutzklasse

Gewicht (inkl. Sensorkopf und Batterien)
Abmessungen

Lagertemperatur

Betriebstemperatur
Batteriestandsanzeige

Steuerungsausgang

Analogausgang

ppm oder mg/m?3

9,6 V Akkupack (2100mAh, Ni-MH) oder Netzgerat
(12 v DC, 800 mA)

IP 20

Ca. 460 g

195 x 122 x 54 mm

210°C

-5°C...50°C

Symbol im Display

AUnbedingt Diode verwenden! (siehe Kap. 5.4.1)
12 VDC oder Schalter zu Masse (max. 150 mA)
0-5V
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3.1 Spezifikationen der Sensorkopfe

Sensor

Ammoniak
0..100 ppm

Ammoniak
(Leck)
0 ... 1000 ppm

Kohlenmonoxid
0 ... 100 ppm

Kohlenmonoxid
0 ... 1000 ppm

Kohlendioxid
0 ... 2000 ppm

Kohlendioxid
0 ... 5000 ppm

Kohledioxid
0..5%

Wasserstoff
0 ... 5000 ppm
1)

Schwefelwasser-
stoff
0...10 ppm

(1)

Schwefelwasser-
stoff

Kali-
brierter
Bereich
0...100
0...1000
0...100
0...1000
0 ... 2000
0 ... 5000
0..5%
0 ... 5000
0..10
0..50

Hochst- LDL
belastung

200 0,5 ppm
2000 2 ppm
200 0,5 ppm
2000 1 ppm
NA -

NA -

NA -

20000 5 ppm
25 10 ppb
100 0,05 ppm

Genauigkeit

<+5ppm

<+15%

<t5ppm

<+ 10 ppm

<+ (40 ppm + 3 %)

<+ (150 ppm + 5 %)

<+x5%

<+10%

<+ 1 ppm (0-10 ppm)
<+ 2 ppm (10-50
ppm)

<*15%

Auflésung

0,1 ppm

1 ppm

0,1 ppm

1 ppm

10 ppm

10 ppm

0,01 %

1 ppm

0,01 ppm

0,1 ppm

Ansprech-
zeit

<60s

<60s

<150s

<150s

<60s

<60s

<60s

<90s

<60s

<60s

Sampling-
methode

Betriebs-
temperatur

-20°C...40°C

-20°C...40°C

0°C..

0°C..

0°C..

0°C..

-20°C...40°C

-20°C...40°C

-20°C ...40°C

..40°C

40 °C

40 °C

40 °C

40 °C

www.warensortiment.de

Maximale relative

Feuchtigkeit
im Betrieb

5..

95 %

.. 95 %

.95 %

.95 %

.95 %

. 95%

.. 95%

.95 %

.95 %

.. 95%
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0...50 ppm
Methan 0...9999 |10000 - <+15% 1 ppm <60s F 0°C..40°C 30...80%
0 ... 10000 ppm
Ozon 0.. 0,250 1 ppb <+ 0,005 ppm 0,001 ppm [<70s F -5°C..40°C |5..95%
0 ...0.150 ppm 0,150
Ozon 0.. 1 1 ppb <+ 0,008 ppm 0,001 ppm |<60s F -5°C..40°C |5..95%
0..0,5ppm 0,500 (0...0,1 ppm)

<+10%

(0,1...0,5 ppm)
Ozon (2) 0,5..20 |25 10 ppb <+10% 0,01 ppm <35s F -5°C..40°C |5..95%
0,5 ... 20 ppm (0,5 ... 2 ppm)

<+15%

(2 ...20 ppm)
Ozon Fur die Detektion von Lecks bei IDLH-Referenzwert 5 ppm | 0,01 ppm <10s F -5°C..40°C |5...95%
(Leck) (IDLH = Immediately Dangerous to Life & Health)
NMHC (3), (4) 0..25 50 Olppm |<+10% 0,1 ppm <60s F -20°C...40°C |5...95%
0...25 ppm (0,1 ... 25 ppm)
Perchlorethylen 0..200 |250 1 ppm <5 ppm 1 ppm <5s F 0°C..40°C 5..95%
0 ... 200 ppm (0 ... 50 ppm)

<+10%

(50 ... 200 ppm)
Schwefeldioxid 0..10 20 0,2ppm | <x0,5ppm 0,01 ppm <60s F -20°C...40°C |5...95%
0...10 ppm
Schwefeldioxid 0..100 |200 0,5ppm |<+x10% 0,1 ppm <60s D -20°C...40°C |5...95%
0...100 ppm
VOC (4) 0..25 50 0lppm |<+10% 0,1 ppm <60s F -20°C...40°C |5...95%
0 ... 25 ppm (0,1 ... 25 ppm)
VOC (4) 0...500 |1000 1 ppm <+10% 1 ppm <60s F -20°C...40°C |5...95%


http://dict.leo.org/ende?lp=ende&p=CqhggsWkAA&search=Perchlorethylen&trestr=0x2001
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0 ... 500 ppm

Temperatur -20 ... -40 ... 100 |0,01°C <+x3°C 0,01 °C <ls - -40 ...120°C |0...100 %
100 °C °C

Feuchtigkeit 0.. 100 % 1%rF. [2%Tr.F. 1%r.F. <ls - -40 ...120°C |0...100 %
100 %

(1) Andere spezifische Konzentrationen auf Anfrage

(2) Genauigkeit < 0,5 ppm nicht spezifiziert (fir Messungen welche Genauigkeit unter < 0,5 ppm verlangen, benutzen Sie spezielle Sondenkdpfe fir
Niederbereichsmessungen)

(3) Kein Methan-Kohlenwasserstoff-Sensor (geringe Empfindlichkeit gegentber Alkoholen und Ester)

(4) Kalibriert in Abhangigkeit von Isobuten. Andere VOC-Kalibrierungen auf Anfrage

(5) D = Diffusion, F = Lufter
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4 Geratebeschreibung
(Abbildung von AQ300 gilt schematisch auch fir AQ500)

(1) Sensorkopf

(2) Power-Taste (Standby-Taste)
(3) Display

(4) Alarmtonstummschaltung (Mute)
(5) Enter-Taste (Eingabetaste)

(6) Scrollen (Hoch)

(7) Scrollen (Runter)

(8) Batteriefach

1— @ D (1) Power-Taste
(2) Alarmtonstummschaltung (Mute)
[~ Rl (3) Enter-Taste
(4) Scrollen (Hoch)
2— @ [\ Rl (5) Scrollen (Runter)

5 Betriebsanleitung

5.1 Einsetzen des Akkupacks

A
st

1. Klappen Sie die Batteriefachabdeckung (5) vom Gerat weg

2. Verbinden Sie den elektrischen Anschluss des Akkupacks mit dem des Messgerats

3. Legen Sie das restliche Verbindungskabel in die vorgesehene Aussparung und fiihren Sie den
hinteren Teil des Akkupacks in die Gelenkpunkte des Batteriefachs ein

4. Fihren Sie den vorderen Teil des Akkupacks in die Halteclips ein (beachten Sie eventuelle
Ausrichtungshinweise auf dem Akkupack)

5. Setzen Sie die Batteriefachabdeckung wieder auf

5.2 Laden des Akkupacks

Da das Geréat Uber ein intelligentes Management zur Ladung verfligt, erfolgt der Ladeprozess nur
wenn das Gerat eingeschaltet ist oder sich im Standby-Modus befindet. Wahrend der Ladung blinkt
das Batteriesymbol im Display in niedriger Frequenz. Das Akkupack kann mit oder ohne montierten
Sensorkopf im Gerat geladen werden (achten Sie drauf vor Demontage des Kopfes das Gerét
auszuschalten). Nach einer Hochstladezeit von 15 Stunden beendet das Gerét den Ladevorgang.
Ziehen des Netzsteckers bewirkt einen Neubeginn der Ladezeit. Neue Ni-MH-Batterien missen vor der
ersten Nutzung vollstandig geladen werden. Eine Ni-MH-Batterie entfaltet die volle Leistungsfahigkeit erst
nach mehreren Zyklen von Ladung/Entladung. Ein vollgeladenes Akkupack hélt fir eine Dauer von ca.
sieben Stunden (Perchlordthylen-Sensoren haben einen hoheren Stromverbrauch und somit eine
verkirzte Akkulaufzeit). Der Ladeprozess dauert im Standbymodus ca. 10, im Betriebsmodus ca. 15
Stunden.

Das intelligente Lademanagement der Version 5.1 beendet den Ladevorgang wenn eine der folgenden
Bedingungen vorliegt:

e Die volle Ladung von 10,5 V wurde erreicht

e Es wurde fur 15 Stunden geladen

e Die Batterie kann keine weitere Ladung aufnehmen


http://dict.leo.org/ende?lp=ende&p=CqhggsWkAA&search=Perchlor%C3%A4thylen&trestr=0x2001
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Wenn die Batterie nicht mehr Uiber die volle Kapazitat verfugt (ein Zeichen fur Alterung der Batterie), wird
im Batteriesymbol des Displays ,RB* angezeigt. Ein Austausch der Batterie empfiehlt sich.

5.3 Warmlaufphase

Vor der Nutzung bendtigt das Gerat eine Aufwarmphase, um Verunreinigungen des Sensors zu
verbrennen. Nach dem Einschalten warmt das Gerét fur drei Minuten auf. Danach blinkt die Anzeige fur
weitere sieben Minuten, um zu zeigen dass das Gerat noch immer in der Aufwarmphase ist. Es empfiehlt
sich das Gerat bei Nichtnutzung im Standby-Modus zu belassen, um den Sensor warm zu halten und so
Verunreinigung des selbigen zu verhindern. Wenn das Gerét mehr als sieben Tage ausgeschaltet war,
sollte es vor einer Benutzung fir 24 Stunden (Uber den Netzadapter) betrieben werden.

Warnung: Nehmen Sie den Sensorkopf nicht ab wéhrend das Gerat eingeschaltet ist! Dies
kann das Gerat beschadigen. Sollte dennoch eine Demontage des Sensors bei
eingeschaltetem Gerat erfolgen, schaltet dieses sich automatisch ab.

5.4 Externer Kontrollanschluss

Die Pins fur den externen Ausgangsanschluss sind von 1-6 nummeriert. Pin 1 ist jener, welcher sich am
nahersten zum Anschluss des Netzadapters befindet.
Die Pinbelegung lautet wie folgt:

(1) 12v DC

(2) Analoger Ausgang 0-5 V

(3) Steuerung

(4) High-Alarm

(5) Low-Alarm

(6) Masse

Der RJ12-Anschluss erlaubt zwei Arten der Verkabelung, entweder einen Schalter zu Masse, oder ein 12
V-Ausgang. Wenn der 12 V-Ausgang genutzt wird, erfolgt die Versorgung der Relaisspule durch den
gerateinternen AC/DC-Richter. In diesem Fall ist darauf zu achten, dass das Relais nicht mehr als 150
mA zieht und eine Schutzdiode parallel zur Spule geschaltet ist. Wird der Schalter zu Masse benutzt, darf
zusatzlich die Spannung 24 V nicht Uberschreiten.

5.4.1 Alarmanschluss
Hinweis: Diese Funktion kann nur benutzt werden wenn das Geréat mit dem Netzadapter betrieben wird.

Die Pins fur High- oder Low-Alarm kénnen verwendet werden um einfache Ein-/Ausschalter zu
versorgen, welche wiederum Gerate steuern die lediglich ein Ein-/Ausschaltsignal benétigen, z.B.
Sirenen. Um zu Masse zu schalten, benutzen Sie die Pins (4), (5) und (6). Fir den 12 V-Ausgang
bendtigen Sie die Pins (4), (5) und (1). Die Werkseinstellung basiert auf dem Sensorkopf welcher bei
Geratekauf ausgesucht wurde.

Alarm bei hoher Gaskonzentration

+ 12V nom. \I

A
? o

Warnung: Das Weglassen der erwdhnten Diode kann einen Defekt des Gerates zur Folge
haben, wenn durch das Relais eine Spannungsspitze erzeugt wird.

5.4.2 Steuerungsanschluss
Hinweis: Diese Funktion kann nur benutzt werden wenn das Gerét mit dem Netzadapter betrieben wird.

Der Pin der Steuerung (3) kann verwendet werden um, mittels Steuerung, eine Gaskonzentration
zwischen oberer und unterer Grenze zu halten. Die obere und untere Grenze kann vom Benutzer

o)
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festgelegt werden. Die Werkseinstellung basiert auf dem Sensorkopf welcher bei Geratekauf ausgesucht
wurde.

Um auf Masse zu schalten benutzen Sie die Pins (3) und (6). Fur einen 12 V-Ausgang, schalten Sie die
Pins (3) und (1). Steuerung wird durch Verwendung der Software erreicht. Wird dem Messgeréat die
Versorgungsspannung entzogen, 6ffnet sich der Schalter, wodurch das gesteuerte Gerat abgeschaltet
wird (soweit einem ,Schliel3er-Prinzip“ gefolgt wird).

Steuerung der Gaskonzentration

O
+ 12V nom. >

- * Steuerkreis

= 1 X

f Warnung: Das Weglassen der erwahnten Diode kann einen Defekt des Gerates zur Folge

L R O e

RI12

haben, wenn durch das Relais eine Spannungsspitze erzeugt wird.

5.4.3 Anschluss des 0 ... 5 V-Analogausgangs (zwischen Pin (2) und Pin (6))

Das Ausgangssignal ist ein Signal welches in der Hohe proportional der Gaskonzentration entspricht. Die
Spannungsaufteilung entspricht dem jeweiligen Messbereich des spezifischen Gases, z.B. entspricht
beim Ozonsensor fir niedrige Konzentrationen eine Spannung von 0 V einer Konzentration von 0 ppm,
eine Spannung von 5 Volt einer Konzentration von 0,5 ppm Ozon.

5.5 Ein- und Ausschalten des Gerats

Um das Geréat einzuschalten, driicken und halten Sie die Power-Taste (2) bis ein Ton erklingt und das
Display aktiviert wird. Im Display wird die Version des Geréts und der Software angezeigt. Nach flnf
Sekunden wird der Sensortyp angezeigt und die Aufwarmphase (wie oben beschrieben) beginnt. Nach
Abschluss der Aufwarmphase erfolgt die Hauptanzeige, wie hier exemplarisch erkennbar:

R 35.5% Hinweis:

y 216 Q3 LOW
™ ostow 4~ Die Anzahl der

Dezimalstellen kann, je
0.009
ppm 0 ' 0 09 nach verwendetem
. ppm s .
Serie 303/505 ensorkopf, variieren

Um das Gerat auszuschalten, dricken und halten Sie die Power-Taste (2) fur ca. zwei Sekunden. Ein
Ton erklingt und die Displayanzeige verschwindet.

5.6 Ein- und Ausschalten des Standby-Modus

Um bei eingeschaltem Gerét in den Standby-Modus zu gelangen, driicken Sie (einmalig und kurz) die
Power-Taste (2). Dies beendet die Messfunktion; der Sensor wird jedoch warmgehalten. Dieser Modus
ermdoglicht es Energie zu sparen, und dennoch nur eine kurze Aufwarmphase bei Wiederaufnahme der
Messtatigkeit hinnehmen zu missen. Die Displayanzeige sieht bei Standby wie folgt aus:

NH3 c)

Um in den Messmodus zuriickzukehren, driicken Sie erneut (einmalig und kurz) die Power-Taste.

Hinweis: Bei Verwendung eines Kohlendioxid-Sensors wird dieser im Standby-Modus mit voller Leistung
betrieben. Auch der Lufter bleibt eingeschaltet.

5.7 Batteriebetrieb

Bei Arbeiten im reinen Batteriebetrieb wird im unteren Displaybereich ein Batteriesymbol angezeigt. Das
Symbol verandert sich mit dem Ladestand der Batterie.

10
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5.8 Ausfall des Sensorkopfs
Es gibt zwei Anzeigen welche auf ein Problem mit dem Sensorkopf hinweisen:

»Sensor Failure, Replace sensor“: Der Sensorkopf sollte getauscht werden, da ein Komponentenfehler
vorliegt oder der Sensor das Ende seiner Lebensdauer erreicht hat.

»Sensor aging“: Der Sensorkopf sollte schnellstmdglich getauscht werden, da er das Ende seiner
Lebensdauer erreicht hat. Die Messergebnisse sind nicht langer verlasslich.

5.9 Nutzung der Menis und Funktionstasten

Um in das Meni zu gelangen, driicken Sie die Eingabetaste (5). Eine der beiden folgenden Anzeigen
erscheint (links das normale Mend, recht bei aufgestecktem Perchlorathylen-Sensor):

EXIT EXIT
ALARM POINTS CLOCK SETUP
CONTROL POINTS LOGGING SETUP
UNITS ALARM POINTS
MAX MIN AV CONTROL POINTS
ZERO CAL UNITS

MAX MIN AV

ZERO CAL

Serie 300/305 Serie 500/505

Benutzen Sie die Scroll-Tasten (6), (7) um zum gewtnschten Mentpunkt zu scrollen.

5.9.1 Nullkalibrierung (ZERO CAL)

Die Nullkalibrierung legt den Nullpunkt fir die Messung fest. Die Kalibrierung muss unter strengen
Bedingungen erfolgen, wie da waren:
¢ Mindestens 24 Stunden Warmlaufphase
Saubere Luft (Aktivkohle-gefilterte Luft ist am besten geeignet), keine querempfindlichen Gase
Stabiler und geringer Luftzug um das Gerat
Keine Vibration oder Bewegung des Messgerats
Temperatur 20°C £ 2 °C
Relative Luftfeuchtigkeit 50 % + 5 %

Eine fehlerhafte Nullkalibrierung fuhrt nicht zu einem dauerhaften Schaden am Geréat. Die Kalibrierung
sollte allerdings unter 0.g. Bedingungen wiederholt werden.

Warnung: Die Nullkalibrierung von Kohlendioxidsonden muss zwingend in einer qualifizierten,
umgebungsluftfreien Atmosphére erfolgen. Im Zweifelsfall kontaktieren Sie uns bitte.

Dricken und halten Sie die Enter-Taste bis der Schriftzug ,GO“ erscheint. Der Kalibrierungsprozess
nimmt ca. 3-10 Minuten in Anspruch. Nach Abschluss ertont ein Signal.
Dricken Sie die Scroll-Taste (Runter) um zum néchsten Menlpunkt zu gelangen.

5.9.2 Einstellen der Uhr (nur AQ500/505)
Um in das Meni zu gelangen, driicken Sie die Eingabetaste (5). Die folgende Anzeige erfolgt:

14:30:12 (Stunden : Minuten: Sekunden)
Oct 07 02 (Monat Tag Jahr)

Um die Stunden zu &ndern benutzen Sie die Scroll-Tasten. Bestétigen Sie Ihre Einstellungen mit der
Eingabetaste. Bedenken Sie bitte dass es sich um eine 24-Stunden-Uhr handelt. Nach der Bestatigung
rickt der Cursor automatisch zur nachsten Stelle vor. Die Einstellung der anderen Zeitparameter
funktioniert nach demselben Schema. Um zum nachsten Mentpunkt zu gelangen, betatigen Sie die
Scroll-Taste (Runter).

5.9.3 Einstellung des High- und Low-Alarms
Um in das Menl zu gelangen, driicken Sie die Eingabetaste (5).
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Einstellen des High-Alarms
Nach dem Aufrufen des Alarm-Setup-Menus wird ,Alarm HI* angezeigt.

ALARM HI
35 ppm

Benutzen Sie die Pfeiltasten um den Wert zu andern. Bestatigen Sie die Einstellung mit der Eingabetaste.

Einstellen des Low-Alarms

Nach Bestatigung der Einstellung des High-Alarms wechselt die Ansicht automatisch in die Einstellung

des Low-Alarms. Im Display wird ,Alarm LO" angezeigt.

ALARM LO
0.040 ppm

Benutzen Sie die Pfeiltasten um den Wert zu andern. Bestatigen Sie die Einstellung mit der Eingabetaste.

Hinweis: Diese Einstellung gilt fir den Geratealarm und den externen Alarm.

Ein- und Ausschalten des Alarms
Nach Bestatigung der Einstellung des Low-Alarms wechselt die Ansicht automatisch in die ,Buzzer*
Einstellung.

BUZZER
ENABLE (or)
DISABLE

Benutzen Sie die Pfeiltasten um zwischen ,ENABLE" (Aktiviert) und ,DISABLE" (Deaktiviert) zu wahlen.
Bestétigen Sie die Einstellung mit der Eingabetaste.

Hinweis: Wenn der Alarm deaktiviert wurde, gilt diese Stummschaltung permanent. Ein ,P* im Display
(rechts neben dem Stummschaltungssymbol) symbolisiert dies.

Displayanzeige bei High-Alarm
03 HIGH

t4 8.00

Zwei nach oben weisende, blinkende Pfeile erscheinen im Display wenn die Ozonkonzentration Giber 8.00
ppm steigt. Akustisch wird der Alarm durch ein schnelles Piepen begleitet.

pm

Displayanzeige bei Low-Alarm
O3 LOW

I 0.015

ppm

Zwei nach unten weisende, blinkende Pfeile erscheinen im Display wenn die Ozonkonzentration Uber
0,015 ppm steigt. Akustisch wird der Alarm durch ein langsames Piepen begleitet.

Displayanzeige bei Alarm-Mute (Alarmstummschaltung)
CcO
35
1t ppm

Diese Funktion wird durch Betatigung der Mute-Taste (4) aktiviert und durch einen durchgestrichenen
Lautsprecher im Display symbolisiert. Stummschalten eines aktiven High- oder Low-Alarms gilt nur so
lange die aktuelle Alarmbedingung vorliegt. Bewegt sich die Ozonkonzentration wieder in die
Schrankenwerte, wird die Stummschaltung deaktiviert.

Displayanzeige bei permanentem Alarm-Mute (permanenter Alarmstummschaltung)

35
ttp ppm

=
N
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Das Symbol (durchgestrichener Lautsprecher und ,P*) wird permanent angezeigt, bis die
Stummschaltung im Menu aufgehoben wird. Sollte eine Alarmgrenze Uberschritten sein, werden die
blinkenden Pfeile angezeigt. Ein akustisches Warnsignal ertont nicht.

Dricken Sie die Scroll-Taste (Runter) um zum ndchsten Menlpunkt zu gelangen.

5.9.4 Einstellen der Steuerpunkte (Control points)
Um in das MenUl zu gelangen, driicken Sie die Eingabetaste (5).

Einstellen des High-Steuerpunktes
Nachdem das Control-Menl aufgerufen wurde, erfolgt die Anzeige ,CONTROL HI“.

CONTROL HI
0.080 ppm

Benutzen Sie die Pfeiltasten um den Wert zu andern. Bestatigen Sie die Einstellung mit der Eingabetaste.

Einstellen des LO-Steuerpunktes
Nach Bestatigung der Einstellung des High-Steuerpunktes wechselt die Ansicht automatisch in die
Einstellung des Low-Steuerpunktes. Im Display wird ,CONTROL LO" angezeigt.

CONTROL LO
0.040 ppm

Benutzen Sie die Pfeiltasten um den Wert zu andern. Bestatigen Sie die Einstellung mit der Eingabetaste.
Dricken Sie die Scroll-Taste (Runter) um zum nachsten Menlpunkt zu gelangen.

Hinweis: Nachdem die Steuerpunkte eingestellt wurden, muss das Gerat entweder in den Standby-
Modus versetzt oder ausgeschaltet werden um die neuen Einstellungen zu aktivieren.

5.9.5 Einstellen der Zeitintervalle des Datenloggers (hur AQ500/505)
Um in das Logging-Menu zu gelangen, driicken Sie die Eingabetaste (5). Die Anzeige ,LOG FREQ*
erscheint.

LOG FREQ:
1 MIN

Benutzen Sie die Pfeiltasten um den Loggingwert in 1-Minuten-Schritten zu andern. Bestatigen Sie die

Einstellung mit der Eingabetaste und die folgende Anzeige erscheint:

CLEAR LOG
NO

Sie kdnnen nun wahlen ob sie die geloggten Daten |6schen oder behalten méchten, indem Sie, mittels
der Pfeiltasten, zwischen ,YES® und ,NO* wahlen. Hierbei bedeutet ,YES* dass die Daten geldscht
werden sollen. Bestétigen Sie die Einstellung mit der Eingabetaste und die folgende Anzeige erscheint:

LOGGING
OFF

Benutzen Sie die Pfeiltasten um zwischen ,ON" und ,OFF* zu wahlen. Bestatigen Sie die Einstellung mit
der Eingabetaste und das Hauptmenu erscheint.
Dricken Sie die Scroll-Taste (Runter) um zum néchsten Menlpunkt zu gelangen.

5.9.6 Andern der Messeinheit (UNIT)

Drucken Sie die Enter-Taste um in das Menu ,UNITS" zu gelangen. Einmaliges Driicken fuhrt in die
Einstellung der Einheit fur Konzentration, zweimaliges Driicken in die Einstellung der Einheit fir
Temperatur (nur bei AQ305/505).

|A
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CONC UNIT: TEMP UNIT:
ppm (or) °C (or)
mg/m?® °F

Benutzen Sie die Pfeiltasten um zwischen ,ppm*“ und ,mg/m*‘, bzw. ,°C* und ,°F* zu wahlen. Bestatigen
Sie die Einstellung mit der Eingabetaste.
Driicken Sie die Scroll-Taste (Runter) um zum nachsten Menlpunkt zu gelangen.

5.9.7 Max/Min/Durchschnitt des Messungsdurchlaufs

Betatigung der Enter-Taste startet/stoppt die Max/Min/Durchschnitt-Prozedur. Driicken Sie die Scroll-
Taste (Runter) um zum Punkt ,EXIT“ zu scrollen. Driicken Sie die Enter-Taste um die MenUueinstellungen
zu verlassen. Hierdurch wird auch, je nach Menuauswabhl, der Durchlauf gestartet.

Hinweis: Es gibt auch eine Tastenfunktion, welche ein schnelles starten/stoppen des Durchlaufs
ermdglicht. Driicken und halten Sie hierzu im Hauptbildschirm die Scroll-Taste (Runter) fir mindestens
zwei Sekunden, bis der akustische Signalgeber ertont. Hierdurch wird der Durchlauf gestartet und die
folgende Anzeige erscheint (die rechte Darstellung bezieht sich auf AQ305/305):

03 LOW O3 LOW TEMRH

PPM c %
MIN 0.005 ' 05 22 0
MAX 0.024 k}x 3353 25 ?é
AVE 0.015 0008 AVE 0015 24 54
ST 0013 ST 0013

ppm ®

Um die Messung zu stoppen, driicken die erneut die Scroll-Taste (Runter) fir mindestens zwei
Sekunden, bis der akustische Signalgeber ertont.

Hinweis: Die MIN, MAX und AVE-Werte sind Minimal-, Maximal- und Durchschnittswerte seit Beginn des
Messungsdurchlaufs. Der Wert ,ST* ist der Durchschnittswert Gber die letzen 15 Minuten.

5.10 Starten und Stoppen des Datenloggings (hur AQ500/505)

Driucken und halten Sie hierzu im Hauptbildschirm die Scroll-Taste (Runter) flir mindestens zwei
Sekunden, bis der akustische Signalgeber ertdnt. Hierdurch wird die Aufzeichnung gestartet. Im unteren
Bereich des Displays erscheint ein Dreieck.

0.024
A ppm

Um die Aufzeichnung zu stoppen, driicken die erneut die Scroll-Taste (Runter) fir mindestens zwei
Sekunden, bis der akustische Signalgeber ertont.

Hinweis: Das Dreieck-Symbol zeigt dass die Datenlogging-Funktion aktiv ist, aber dient auch der
Statusanzeige fur den Speicher:
e Ein leeres Dreieck signalisiert dass keine Daten gespeichert sind
e Ein halbvolles Dreieck signalisiert dass einige Daten gespeichert sind
e Ein volles Dreieck signalisiert dass de Speicher voll ist und sein Inhalt auf den PC Uberspielt
werden sollte.

5.11 Ldschen des Datenspeichers

Um den Datenspeicher zu ldschen, muss das Logging zuvor beendet werden. Der Speicher kann dann
durch Driicken und Halten der Mute-Taste (4) fur Uber zwei Sekunden geléscht werden. Die Léschung
wird durch ein akustisches Signal bestatigt. Alternativ kann im Menu ,LOGGING SETUP*“ die Funktion
»,CLEAR LOG" genutzt werden.

6 Anleitung fur die Software

Die Software der Gerate AQ500 und AQ505 fiir Microsoft Windows ™ enthalten Java"™1.5.0 runtime
virtual machine, eine Java-Datenbank und alle nétigen Komponenten um die Software in Verbindung mit
dem Gerét zu betreiben.

Hinweis: Das AQ505 speichert sowohl Gaskonzentration, relative Feuchte, wie auch Temperatur.
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6.1 Softwareinstallation

Softwarelizenz

Die Gerate AQ500 und AQ505 werden zusammen mit der Software ausgeliefert. Der Hersteller behalt
das geistige Eigentum. Der Kaufer erkennt an, dass ihm eine unbefristete, nicht-exklusive, nicht
Ubertragbare Lizenz zur eigenen Nutzung der Software nur in Zusammenhang mit dem Messgerat erteilt
wird. Der Kaufer wird sich strikt an diese bestimmungsgenmafe Nutzung halten und die Software nicht
Ubersetzen, umarbeiten, dekompilieren, deassemblieren oder in sonstiger Weise abandern. Der K&aufer

akzeptiert die Software nicht zu verkaufen, vermieten, Gbergeben, vertffentlichen, verleihen, Sublizenzen
zu vergeben oder die die anderweitig weiterzugeben.

Softwarefeatures

Echtzeit-Uberwachung der Gaskonzentration und Aufzeichnung von Daten
Ereigniserfassung. Wenn die Gaskonzentration eine, durch den Anwender definierte, Grenze
Uberschreitet, wird dieses Ereignis erfasst und in der Datenbank hinterlegt

Datenanalyse der gespeicherten Werte mittels graphischer Darstellung. Die Darstellung kann
durch den Anwender konfiguriert werden

Das durchschnittliche Level der Gaskonzentration kann sowohl in der Echtzeitanzeige als auch in
der Darstellung der Speicherwerte erfolgen

Graphische Darstellungen kénnen als JPG-Datei gespeichert werden

Geloggte Daten kénnen in anderen Formaten (z.B. zur Verwendung mit Microsoft Excel™)
exportiert werden.

Konfiguration der Geréateeinstellungen vom PC aus

Sicherung und Widerherstellung von geloggten Daten

Dem Sensor kann ein Name oder eine ID zugeteilt werden. Der Name kann gedndert werden
Der Umrechnungsfaktor fir die Einheiten (ppm oder mg/m3, bzw. °C oder °F) kann verandert
werden

Daten verschiedener Sensoren kénnen in derselben Datenbank gespeichert werden, missen
jedoch separat heruntergeladen werden

Die Gerateversionen V5.0 und héher sind nicht mit friheren Softwareversionen kompatibel

Systemanforderungen

Betriebssystem: Microsoft Windows™ 2000, XP, Vista
Prozessor: 600 MHz oder schneller.

Arbeitsspeicher (RAM): 256 MB (Minimum)
Verfligbarer Festplattenspeicher: 90 MB (Minimum)
Schnittstelle: Seriell (oder mittels USB-Seriell-Adapter)

Installationsvorgang

Legen Sie die CD-ROM in das CD-ROM-Laufwerk des Computers ein

Offnen Sie die Datei ,S500-x-x.exe“ und folgen Sie den Anweisungen des
Installationsprogramms

(Bei Windows Vista, entpacken Sie die Vista-Software, welche sich daraufhin selbststandig
installieren sollte)

6.2 Benutzung der Software

Verbinden Sie das Messgerat mittels des beiliegenden Kabels mit dem COM-Anschluss lhres
Computers

Schalten Sie das Gerét ein

Starten Sie das Programm S500. Die folgende Anzeige erfolgt:

|A
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Einstellen der Software- und Geréateparameter

Dieses Kapitel der Anleitung befasst sich mit dem Vorgehen um mittels der Software Alarme, externe
Steuergrenzen, Loggingzeiten, Einheiten und Sensorverhalten festzulegen.

Wahlen Sie ,Monitor -> Setup” oder driicken Sie ,Strg+P*“.Die folgende Anzeige erfolgt:

o zastar Ssten al

[t v e Geben Sie die gewiinschten Werte ein. Klicken Sie den Button ,Upload” um die
e Einstellungen der Software mit dem Gerét zu synchronisieren. Wenn der Upload
Aberht ICEE: beendet ist piept das Gerét. Klicken Sie den Button ,,0k“ um die Einstellungen
‘,"":‘MMW“L = der Software zu bestatigen.
e Um sinnvolles Datenlogging zu betreiben ist es notwendig die Uhrzeit des
otk — Gerats korrekt einzustellen. Dies kann direkt Uber die Tastatur des Geréts oder
Sl gE! Uber den Button ,Update Clock® der Software erfolgen.

Conceetratinling forv =

il © I Hinweise: Wenn Sie ein AQ505 benutzen, vergewissern Sie sich dass das
i il =11 Kontrolifeld ,S505 base with Temp/RH sensor* aktiviert ist. Dies konfiguriert die
kel | e | wances ||| Software auf S505 und zeigt ein Feld welches mit ,Temperature Unit* benannt

o] o | ist. Die Gerateeinstellungen konnen mittels des Buttons ,Download“ auf den PC

aufgespielt werden.

Konfiguration der Gassensoreigenschaften
Wahlen Sie ,Monitor -> Setup“ oder driicken Sie ,Strg+P*“. Wahlen Sie die Registerkarte ,Gas Sensor®.
A E
Confipaain (5% Ser | Im Feld ,Sensor Name* kann ein beliebiger Name fiir den Sensor mit bis zu
sieben Zeichen festgelegt werden. Der Umrechenfaktor von ppm auf mg/ms3
ist anderbar um an unterschiedliche Sensoren angepasst zu werden. Durch
il ol Klicken des Buttons ,Update“ werden die momentanen Einstellungen im
el B Sensorkopf gespeichert. Mittels des Buttons ,View" kann die momentan im

pheee Rwa v Sensorkopf gespeicherte Einstellung betrachtet werden.
Newrx Harge () E!,

Semot Nare: o LOW

wawe | vew |
(o] oo |

Konfiguration der Schnittstelle
Monitor = x|| Hinweis: Wenn Sie nicht tiber eine serielle Schnittstelle verfiigen, ist ein

Com Port Setting entsprechender USB-Adapter erforderlich.
Rufen Sie die Schnittstelle auf in welche das Kabel des Messgerates eingesteckt
wurde. Wenn es sich nicht um COM1 (Voreinstellung) handelt, muss die
Konfiguration auf COM2 oder einen anderen Port vorgenommen werden.
oo Waéhlen Sie ,Monitor -> Com Port* oder driicken Sie ,Strg+M®. Die links
ks = = abgebildete Anzeige erfolgt. Wahlen Sie den entsprechenden Anschluss aus.
Die anderen Werte sollten nicht verandert werden. Bestatigen Sie lhre Auswahl
mit dem Button ,,Ok*.

Port:
Baud rate:

Data Bits:

|_\
(o))



@ BETRIEBSANLEITUNG

www.warensortiment.de

i —re— «| Konfiguration der graphischen Darstellung
s — Im Dialogfeld ,Graph Styles® kdnnen die Eigenschaften der Graphen
s o = gespeicherter Daten und Echtzeitbeobachtungen festgelegt werden. Das
o e ke | T Dialogfeld umfasst die Punkte:
v e T ;
e o Achsabsghnltte der operen gnd unteren Gasskalen
SeanR —_ e Skalenteilung und Zeiteinheiten
Az rors e coke: [ e Farben des Graphen und des Hintergrundes
et e Farben Alarm- und Steuerpunktlinien
ControlSet FortLrecoke: | .
I~ shens Cerirelse: Pkt Lre e Typ des Graphen (Linie oder Punkte)
o L e Durchschnittslinie ein- oder ausblenden
F Deaang nPonks s Uoss
: EE——] Um in die Einstellungen zu gelangen:
o | | Waéhlen Sie ,Data -> Graph -> Default Style“. Bestéatigen Sie lhre Auswahl

mit dem Button ,Ok*.
Einstellen der Loggingeigenschaften
Datenlogging bei AQ500 und AQ505

Ein Messgerat des Typs AQ500 kann bis zu 4300 Datenpunkte (3400 bei AQ505) in seinem internen
Speicher ablegen.

Ansehen der Sensoreigenschaften

Diese Funktion wird benutzt um Sensorinformationen der Datenbank zu aktualisieren und Verbindungen
zu testen. Klicken Sie ,Monitor -> View Sensor Properties”. Das Messgerat muss eingeschaltet und mit
dem PC verbunden sein. Um die Sensordaten der Datenbank zu aktualisieren, klicken Sie den Button
,Save“, nachdem Sie die erforderlichen Anderungen vorgenommen haben. Um Daten mit demselben
Messgerét, aber unterschiedlichen Sensoren aufzuzeichnen, missen bei jedem Sensorwechsel auch die
Eigenschaften in der Software angepasst werden. Wenn die Informationen nicht in der Datenbank
gespeichert sind klicken Sie ,Monitor -> Show Sensor Properties®, passen Sie die Einstellungen an und
klicken Sie den Button ,, Save*“.

Um geloggte Daten vom Geratespeicher auf den PC zu Uberspielen, klicken Sie ,File -> Download
Logged Data“ oder driicken Sie ,Strg+D* oder betétigen Sie das Shortcut-Symbol &.

Wahrend die Daten heruntergeladen werden, wird ein Fortschrittsbalken angezeigt. Nach Abschluss des
Download-Vorgangs piept das Messgerat. Die Software fragt ob die Daten im Speicher des Messegerats
nun geléscht werden sollen. Daten kénnen nur manuell geléscht werden. Eine automatische Léschung,
z.B. nach bestimmter Zeit, erfolgt nicht.

Wenn der Datendownload nicht abgeschlossen, abgebrochen oder unterbrochen wird:

Schalten Sie das Messgerat aus um Datenverlust zu vermeiden

Ldschen Sie die Daten welche bereits auf den PC libertragen wurden

SchlieRRen Sie die Software

Wiederholen Sie den Download-Vorgang (vergessen Sie nicht dass das Gerat eingeschaltet sein
muss)

Direktes Datenlogging auf einen PC

Klicken Sie ,File -> Start PC Data Logging“ oder das Symbol

Die Daten werden nun direkt in der Datenbank auf dem PC gespeichert. In diesem Modus werden keine
Daten im gerateinternen Speicher abgelegt. Wenn der Vorgang des direkten Datenloggings jedoch
beendet wird (durch Klick auf den Button ,Stop® =*), werden die ab diesem Moment folgenden
Messdaten wieder im gerateinternen Speicher aufgezeichnet. Wéhrend direkt auf den PC geloggt wird,
wird ein Echtzeit-Graph/Tabelle gezeigt:
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Hinweise: Temperatur- und Feuchtigkeitsgraphen werden nur angezeigt wenn das Kontrollfeld fur ,S505¢
der Software aktiviert wurde. Neue eingehende Daten werden an unterster Stelle in der Tabelle
hinzugefiigt. Die maximale Zeilenzahl der Tabellenansicht betrégt 50.

Graphik- und Datenanalysefunktionen
anzusehen:

alnix

Um sich geloggte Daten als Graphen

e e e e Stellen Sie sicher dass alle Daten vom Messgerat auf
den PC (bertragen wurden

¢ Klicken Sie ,Data -> Graph -> Logged Data“,
oder Strg+G

e Wabhlen Sie den Zeitraum dessen Daten im Graphen
dargestellt werden sollen

e Wabhlen Sie die gewilinschte Zeiteinteilung und den

O3 LOW Concentration
Froen: 11 Mar 05 1004 To: 11005 1300
[ wares

| T —

friwaras

§ fizaa0

i i 3 Sensor

e R e s Trata . . "

o 2 N ¢ Klicken Sie den Button ,Apply“ um den Graphen
—— e aufzurufen

Hinweis: Die Angabe ,Quarters® im Auswahimen( der
Zeiteinteilung steht fur einen Intervall von 15 Minuten.

Drucken einer graphischen Ansicht

Zum Drucken einer graphischen Ansicht driicken Sie den Button ,Print“. Ein Fenster in welchem ein Titel
eingegeben werden kann erscheint. Geben Sie einen Titel ein um die Messung eindeutig zuordnen zu
konnen. Zum Bestatigen klicken Sie den Button ,OK* und folgen den weiteren Anweisungen zum Druck.

Einen Graphen als Bild abspeichern
Klicken Sie den Button ,Save” und vergeben Sie einen Namen. Der Graph wird als JPG-Datei
abgespeichert.

Darstellung der Graphik &ndern )
Klicken Sie den Button ,Style“. Ein Dialogfenster erscheint. Nehmen Sie die gewlinschten Anderungen
vor und bestatigen Sie mit dem Button ,OK".

VergroRern eines Bereichs des Graphen
Zur VergroRerung markieren Sie den gewtinschten Bereich mit der Maus. Beim Loslassen der Maustaste
wird der entsprechende Bereich vergro3ert dargestellt.

Darstellung aus Grundeinstellung zuriicksetzen
Um zur Grundeinstellung der Darstellung zurliickzukehren, betatigen Sie den Button ,Reset".

Geloggte Daten in einer Tabelle anzeigen

Um geloggte Daten in einer Tabelle darzustellen, klicken Sie ,Data -> Table -> Logged Data“, oder
Strg+E. Die Tabelle wird angezeigt. Wahlen Sie den gewinschten Zeitraum und den Sensor. Klicken Sie
den Button ,,Apply* um die Auswahl zu bestatigen und die Daten zu laden. Die Tabelle kann durch Klicken
auf die jeweilige Kolumne sortiert werden (z.B. um nach Konzentration zu sortieren).
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Wenn Daten nicht langer benétigt werden, kénnen sie mittels des
Buttons ,Delete” entfernt werden.

Zum Drucken einer Tabelle driicken Sie den Button ,Print“. Ein
Fenster, in welchem ein Titel eingegeben werden kann, erscheint.
Geben Sie einen Titel ein um die Messung eindeutig zuordnen zu
kénnen. Zum Bestatigen klicken Sie den Button ,OK* und folgen
den weiteren Anweisungen zum Druck.

Um Daten zu exportieren, klicken Sie ,File -> Export Logged Data®“.
Um die Tabellendaten zur Weiterverarbeitung zu speichern, klicken
Sie im Dialogfenster der Tabellenansicht den Button ,Export".
Geben Sie ein Zielverzeichnis sowie einen Dateinamen ein und

wahlen Sie ein Dateiformat (Klarformat oder MS EXCELTM-Format). Klicken Sie den Button ,Save” um die

Daten zu exportieren.

Analyse der Tageszusammenfassung
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24 Stunden angibt.

Die Tageszusammenfassung ist ein Bericht fir jeden Tag,
von Mitternacht bis Mitternacht, welcher die minimale,
maximale und durchschnittliche Gaskonzentration der letzten

Erstellen und Betrachten der Tageszusammenfassung

erstellen.

Daten abhangig.

Zur Erstellung und Betrachtung klicken Sie ,Data -> Analysis
-> Daily Analysis“. Wahlen Sie den Datenbereich und den
Sensor. Klicken Sie den Button ,Apply“ um die Analyse zu

Hinweis: Der Erstellungsprozess kann zehn Minuten oder
langer bendtigen und darf nicht unterbrochen werden. Die
Prozessdauer ist von der Menge der zu verarbeitenden

Mittels des Buttons ,Export* kann die Zusammenfassung als Datei (z.B. fur MS EXCELTM) exportiert
werden. Auch kann der Button ,Delete” zur Léschung der Zusammenfassung genutzt werden. Hierbei
wird nur die Zusammenfassung gel6scht, nicht die zugrundeliegenden Daten.

Ansehen geloggter Ereignisse (Events)

Ein Ereignis liegt vor wenn die Gaskonzentration eine vorgegebene Grenze Uberschreitet. In diesem Fall
erscheint eine Warnmeldung. Diese Warnmeldung dient auch als Dialogfenster. In einem Textfeld kann
festgehalten werden, wie und durch wen ein Problem geldst wurde. Klicken des Buttons ,OK* bewirkt
dass die Meldung in der Datenbank gespeichert wird.

Um diese festgehaltenen Ereignisse anzusehen, klicken Sie ,Data -> Table -> Logged Events*®, oder
dricken Sie Strg+L. Ein Ansichtsfenster erscheint. Auch hier ist wieder ein Datenexport Gber den Button
~Export* mdglich. Das Léschen von Daten erfolgt Uber den Button ,Delete”.
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Fortgeschrittenes Datenmanagement
Gepackte Datei (Zip-database) aus der Datenbank erzeugen

www.warensortiment.de

Um aus der Datenbank eine gepackte Datei zu erzeugen, klicken Sie ,File -> Zip Database®. Wahlen Sie
ein Zielverzeichnis und geben Sie einen Namen ein um eine Datei aus allen gespeicherten Daten zu

erstellen.

Ansehen der erstellten Datei

A

Warnung: Soll eine gesicherte Datenbank angesehen werden, ist es von groRBer Wichtigkeit
dass eine aktive Loggingfunktion nicht unterbrochen wird. Empfohlen wird, eine gesicherte
Datenbank nicht auf dem PC anzusehen auf welchem ein Loggingvorgang durchgefiihrt wird,

da, wenn Daten wiederhergestellt werden, die aktuellen Daten verloren gehen, soweit diese nicht

gesichert wurden.

Ansehen der erstellten Datei an einem anderen PC

e Installieren Sie die Software auf dem gewiinschten PC
e Kopieren Sie die Zip-Datei auf den PC
e Klicken Sie ,File -> unzip Database*

o Wahlen Sie die gezippte Datei und klicken Sie den Button ,OK*

e Betrachten und analysieren Sie die Daten

Ansehen der erstellten Datei an demselben PC

NogakwbrE

Stoppen Sie das PC-Datenlogging (weitere Daten werden im Messgeréat geloggt)

Erstellen Sie aus der vorliegenden Datenbank eine Zip-Datei.

Entpacken Sie die zu betrachtende Datenbank (“File -> Unzip Database®)

Betrachten und analysieren Sie die zu betrachtende Datenbank (,Data -> Table -> Logged®)
Zippen Sie die Datenbank nach dem Betrachten wieder
Entpacken Sie die Datenbank aus 2.

Laden Sie die Daten vom Messegerat auf den PC herunter, welche im Speicher des Messgerats

festgehalten wurden wahrend Sie die andere Datenbank betrachtet haben

©

Datenverlust)

7 Wartung und Reinigung

7.1 Fehlersuche
Fehlerbeschreibung

Gerat lasst sich nicht
einschalten

Externer Alarm und
Steuerung funktionieren
nicht korrekt

Sensorfehler trotz neuem
Sensorkopf

Mdogliche Fehlerursache

Netzgerat defekt

Batterie leer
Messgeréat defekt

Sensorkopf defekt

Falsche RJ12-Pins verwendet

Keine Diode parallel zur externen
Relaisspule

Polaritat der Diode falsch

Unzureichende Warmlaufphase
Unreine Umgebungsluft

Sensor beschadigt

20

Starten Sie das PC-Datenlogging (dies gewahrleistet eine Fortsetzung der Aufzeichnung ohne

Abhilfe

Uberprifen Sie die Leitungen
/Tauschen Sie das Netzgerat

Laden/Wechseln Sie die Batterie
Tauschen Sie das Messgerat
Tauschen Sie den Sensorkopf
Uberpriifen Sie die Verkabelung

Setzen Sie eine Diode ein

Korrigieren Sie die Polaritat

Betreiben Sie den Sensor bei
eingeschaltetem Gerat fir 24-48 h
Bringen Sie das Gerét in eine
andere Umgebung

Tauschen Sie den Sensorkopf
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Hohes Messergebnis trotz
(relativ) gasfreiem Raum

Messergebnis in
gashaltiger Umgebung
hoéher als erwartet

Messergebnis in
gashaltiger Umgebung
niedriger als erwartet

Messergebnis instabil

Datenverbindung instabil
(nur bei AQ500/AQ505)

Umgebungsluft auRergewdhnlich
belastet

Sensor beschéadigt

Ergebnis korrekt
Sensoreinsatz kontaminiert

Sensorlufter defekt
Querempfindliches Gas
vorhanden

Gas reaktiv und bildet Verbindung
vor Erfassung

Gasfluss zu hoch (Ozonmessung)
oder zu gering (Ammoniak- und

VOC-Messung)

Sensor hat Kalibrierung verloren

Ergebnis korrekt

Querempfindliches Gas
vorhanden

Sensor hat Kalibrierung verloren

Spannungsversorgung instabil
Nennstrom falsch
Luftzug zu grof3

Umgebungsbedingungen &ndern
sich schnell

Rauschen tber das Datenkabel

zwischen Messgerat und PC
aufgenommen (AQ505/AQ505)

Leitung unterbrochen
Einstellung des COM-Ports falsch

Uhreinstellung falsch

N
=

Bringen Sie das Gerét in die
vorgebene Umgebung und fuhren
Sie eine Nulljustierung durch
Tauschen Sie den Sensorkopf

Gasgenerator defekt

Netz und Filter des Sensors
reinigen

Tauschen Sie den Sensorkopf

Bringen Sie das Gerét in eine
andere Umgebung und
Uberprufen Sie es mittels einer
bekannten Gaskonzentration
Bringen Sie den Sensor naher an
die Gasquelle

Sorgen Sie fir angemessenen
Fluss in und um den Sensor

Uberholen/Tauschen Sie den
Sensorkopf

Gasgenerator defekt

Bringen Sie das Gerét in eine
andere Umgebung und
Uberprufen Sie es mittels einer
bekannten Gaskonzentration

Uberholen/Tauschen Sie den
Sensorkopf

Sorgen Sie fur stabile Spannung

Sorgen Sie fir korrekte
Stromversorgung
Reduzieren Sie den Luftstrom

Reduzieren Sie die
Umgebungseinfliisse

Stecken Sie das Kabel aus um zu
sehen ob dies die Messung
stabilisiert. In diesem Fall
verwenden Sie ein anderes Kabel
oder schirmen Sie den PC ab.

Prufen Sie das Kabel und die
Anschlisse

Nehmen Sie die korrekten
Einstellungen vor
Synchronisieren Sie die Uhr des
Messgerates mit der Uhr des PC
(mittels der Software). Wenn dies
nicht mdglich ist, kann die
geréateinterne Batterie defekt sein.
Wenden Sie sich an PCE.
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7.1.1 Sensorausfall

Die Geréate verfligen Uber integrierte Diagnosefunktionen um Sensordefekte zu erkennen. Falls ein
Sensorkopf ausfallt, kann er durch wenige Handgriffe ausgetauscht werden. Ein ausgefallener Sensor
kann zu PCE zuriickgesandt werden, um aufbereitet oder entsorgt zu werden.

Steuer- Low-Alarm- | High-Alarm- | Daten-
Fehler- Display- 0-5 Volt- ausgang Ausgang Ausgang logging
beschreibung | anzeige Ausgang (AQ500/
AQ505)
Kein Fehler Glltiger Wert Wie vom Wie vom Wie vom Gultiger
Messwert | proportional Benutzer Benutzer Benutzer Messwert
zum eingestellt | eingestellt eingestellt
Messergebnis
Sensor »Sensor 5V Offen Geschlossen | Geschlossen | 9999
defekt failure”
Sensor Glltiger Wert Wie vom Wie vom Wie vom Glltiger
Uberaltert Messwert | proportional Benutzer Benutzer Benutzer Messwert
+ ,Sensor |zum eingestellt eingestellt eingestellt
aging“ Messergebnis
Verbindungs- | Gerat oV Offen Offen Offen Keine
fehler schaltet Ausgabe
sich ab
Sensor Standby- |0V Offen Offen Offen Keine
Standby Symbol Ausgabe

7.2 Reinigung

Das Gerét sollte nur mit einem feuchten Tuch gereinigt werden. Keine Scheuermittel oder
I6semittelhaltige Reinigungsmittel verwenden.

8 Entsorgung

Batterien durfen aufgrund der enthaltenen Schadstoffe nicht in den Hausmdill entsorgt werden. Sie
mussen an daflr eingerichtete Riicknahmestellen zu Entsorgung weitergegeben werden.

Zur Umsetzung der ElektroG (Rucknahme und Entsorgung von Elektro- und Elektronikaltgeréaten)
nehmen wir unsere Gerate zurtick. Sie werden entweder bei uns wiederverwertet oder Uiber ein
Recyclingunternehmen nach gesetzlicher Vorgabe entsorgt.

Bei Fragen kontaktieren Sie bitte die PCE Deutschland GmbH.

Eine Ubersicht unserer Messtechnik finden Sie hier: http://www.warensortiment.de/messtechnik.htm
Eine Ubersicht unserer Messgeréte finden Sie hier: http://www.warensortiment.de/messtechnik/messgeraete.htm
Eine Ubersicht unserer Waagen finden Sie hier: http://www.warensortiment.de/messtechnik/messgeraete/waagen.htm

WEEE-Reg.-Nr.DE69278128
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Unsere Gerate sind CE
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